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Introduction

This manual explains how to install and use the MTL8455 – Bus Interface Module-
Configuration Software.

The manual is divided into the following topics:

•  The Software Function

•  The User Interface

•  The Application Controls

•  Tasks (How to…)

•  Glossary of Terms

It should be used in conjunction with the manuals for the specific models of MTL8000 BIMs
and the individual data sheets for the range of MTL8000 Process I/OTM modules.

MTL publications:

INM8502 – Profibus-DP BIM instruction manual.

INM8505 – Modbus BIM instruction manual.

Process I/O module data sheets by product number.

The manuals contain information about the individual BIMs, the bus protocols they use and
how their data is mapped. The I/O module data sheets provide additional information on the
performance and parameters available for each module.

Overview
The MTL8455 BIM Configuration Software (also referred to as the “Configurator”) is a
Microsoft Windows application that runs on a standard PC under a Microsoft Windows 95,
Windows 98, Windows 2000, Windows XP or Windows NT4 operating system. The PC must
then be linked via one of its serial ports to the configuration port of the Bus Interface Module.
Where a secondary LAN connection is available to the BIM it may also be configured remotely
via this port.

Purpose
The Configurator is used to create configuration files for Version 2.xx  BIMs using system
parameters selected by the user. This file can then be passed from the PC, via a serial link (or a
LAN), to the BIM. The BIM is unable to operate effectively until this configuration file is in
place. The file passed to the BIM will overwrite any previous file and provide a fresh set of
parameters but will not be permanent until the file is saved to the BIM’s non-volatile-memory.

The configuration file performs a number of vital tasks.

•  It instructs the BIM about the modules it is controlling,

•  It instructs the modules regarding their environment and function

•  It defines how the BIM should talk to the host

•  It defines how the BIM and the modules should behave in the event of a loss of command
communications

•  It provides a migration path between versions by enabling users to import .csv files from
Version 1.xx BIMs in order to create Version 2.xx configuration files.
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Software function

Overview
The principal use of the software is to create configuration files for the Bus Interface Modules.
This involves selecting a BIM that matches the network protocol and then specifying I/O
modules that the BIM will supervise.

Editing functions are provided to add or delete BIMs or I/O modules. Each of these modules is
then configured to define individual operating parameters. The sort of parameters that can be
defined include: the type of sensors connected to the modules; the parameters the modules will
adopt on start-up; the state or value each channel will present when a module enters a failsafe
mode; the alarm levels for individual channels and whether the channel is active or not.

When connected to a live system, the software can also monitor channel data and display the
status of individual modules, so that information is available for diagnostic purposes. It can also
be used to test some of the system functions.

When the configuration file has been defined, it can be downloaded to the BIM and saved in its
non-volatile memory (NVM). This enables the BIM to load this configuration when starting
from initial switch-on. If the file is not saved to NVM, the information will be lost when power
is removed from the BIM, i.e. when the system is powered down or the BIM is removed.

A configuration file can also be uploaded from a BIM. This file can be edited and saved and
then downloaded to other BIMs.

Configuration files
Configuration files have a .cfg file extension and are held in binary format. Files can be viewed
and edited without the need for a BIM to be connected. This enables “offline” construction and
editing to be carried out. They can then be stored and called up as required.

Files produced with the earlier 8450 Configurator can also be imported into the 8455
Configurator and then edited in the same way as files that are initially created in the 8455.

BIM management
Other than commands it receives from the host, the BIM is controlled by the firmware that it
contains. This firmware is contained in flash memory, which means that it can be updated as
newer versions of the software are developed.

I/O module management
Like the BIM, the analog I/O modules contain firmware in flash memory. This firmware can be
changed or updated, as required, by copying the revised firmware file to the module using the
8455 Configurator.

Event log
The Configurator software also contains an Event Log facility. This provides historical
information about significant events for the BIM and I/O modules. The Event Log is capable of
recording error conditions that occur as well as status changes.
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The User Interface

Overview
This section describes how to prepare the software and equipment for use and introduces the
user to the interface and controls that will be encountered when using the 8455 Configurator
application.

The topics include:

•  Installing the software

•  Connecting to the BIM

•  Starting the application

•  The application screen

The following section deals with the application controls and how they are set.

Installing the software
The software is available on a CD from MTL and can be installed on any PC running Microsoft
Windows 95, Windows 98, Windows 2000, Windows XP or Windows NT®. The standard
installation requires < 1Mb of hard disk space but space will be needed also for any
configuration files created. Upgrades to the software are available from the MTL web site
(www.mtl-inst.com)

It is advisable to close all other applications before running the installation wizard. Follow the
instructions provided with the CD and the installation wizard will start.

Note: At any time before the files are copied to the computer the user may retrace one or more
steps in the wizard by clicking on the Back button as many times as required.

Click Next then fill in the Name, Company name and the Product Serial number. Click Next
and the wizard will display the location on the computer hard drive where it will install the
software. If this default location is not suitable, click the Browse button and nominate an
alternative. Click Next to define the type of installation required:

•  Typical – Loads all files likely to be required

•  Compact – Loads the minimum of files to run Configurator

•  Custom – Offers a choice of components for installation

Note: The first time user is advised to continue with the default “Typical” installation. This
option will automatically load files for the Microsoft Data Access Components which are used
to manage the configuration database.

Click Next and a default name for the program folder icon is offered. Accept this as MTL
unless an alternative name is required; in which case enter an alternative or choose from the
existing list provided.

Click Next to begin the installation proper. When the installation is complete a further dialog
box will announce this. Click Finish to complete the task. The user is strongly advised to read
the readme.txt file that is copied to the application folder.

Connecting to the BIM
The Configurator PC can be connected to the BIM via a suitable serial data cable. The Modbus
BIM (8505) has another alternative, which enables a remote connection via the secondary, or
redundant, network to the node's LAN B terminals.

Local connection
The BIM’s RS232 Configurator port is located on its end (top) face in the form of a flush-
mount, male, 9-pin, sub-miniature, D-type connector. An interconnecting cable is required from
the BIM to any serial port (COM1 to COM4) on the PC running the configuration software.
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Such a cable is available from MTL (Part No. 8460-CA-CF). The wiring for this cable is shown
in Figure 1.

Figure 1 - Local configuration cable link
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Pins 2 and 3 are interconnected, in a crossed fashion, and pins 1 and 4 linked at both ends. This
makes the cable symmetrical, to avoid polarity problems. The link between pins 1 and 4
prevents the BIM from going into “failsafe” mode during testing despite the absence of LAN
communication; although, there is a software override for this if the cable is used to connect the
BIM to an 8512 HART interface. See Failsafe with Config on page 24.

Remote connection (Modbus BIM only)
This is the alternative to local connection and allows the user to configure multiple BIMs,
connected to the secondary network, from a single location. This is useful for sites where the
MTL8000 nodes are widely distributed across a large area or in a hazardous location. The
Configurator enables the user to select individual BIMs for configuration.

Figure 2 - Connection options for LAN B
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The PC running the Configurator should be connected, through an RS232 to RS485 (or RS422)
converter (option a above), to the secondary network. Alternatively, an RS485 or RS422 port
could be installed in the PC (option b). Although termed a remote configuration option, the PC
can also be attached to the node locally via the same type of converter.

Starting the application
The main methods of starting the Configurator are as follows:

Starting with the Start button at the left hand end of the Taskbar, use the following sequence:

Start | Programs | Mtl | MTL8000 Configurator

Alternatively, for convenience, a shortcut icon can be added to the computer desktop. Double
clicking this icon will start the Configurator application. (If necessary, see the Windows Help
file for creating desktop icons.)

The Log on screen
On starting the Configurator, the first user screen is the Log on dialog box. This requires a user
name and password.
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Figure 3 - Log On screen

For first time users the default entries are:

User name: admin
Password: admin

The password entry always appears as a set of asterisks to prevent an onlooker from seeing the
password typed on screen. The name and password are not case sensitive, i.e. admin, ADMIN
and Admin will all permit the user to log on.

The system administrator should change this password at the earliest opportunity to
prevent access by unauthorised users. See the later section dealing with Security.

Note: If the Cancel button is clicked, the application will start but will remain in “Read Only”
mode until a user with greater access rights logs in.

The application screen
When the Configurator is started it opens with a blank screen

Figure 4 - The main application screen

Menu bar
The Menu bar is the conventional Windows method of providing the user with a range of
application controls.

Figure 5 - Menu bar

The menu titles are arranged across the top of the application window. By positioning the
mouse pointer on any of title words and then clicking the left mouse button, a drop-down menu
appears with a range of appropriate options.
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Toolbar
The Toolbar provides a set of shortcut buttons for commonly used application controls.

Figure 6 - The application toolbar

These buttons can be used as shortcuts for some of the menu controls. See page 18 for a
description of the Toolbar buttons.

Configuration file display
Each configuration file display is split into two sections, the Navigation Tree and the Parameter
Display Area.

Navigation tree
The Navigation Tree provides a convenient visual method of working with the individual
components of the system. The network is presented with the BIMs and I/O modules connected
to it – shown as icons. The I/O link (LAN) runs vertically with the attached BIMs branching to
the right and any I/O modules branching further right from the BIM. See Figure 7.

Figure 7 - Navigation tree
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Right clicking the mouse on any of the icons in the Navigation Tree will reveal menu options
appropriate to the item clicked. For example, right clicking on a BIM icon will offer, among
other things, the option to add I/O modules to that BIM or download the configuration file to it.

Parameter display area
The parameter display area contains the information relating to the item highlighted in the

Navigation Tree. If the System/Network icon    is highlighted, then the tabs in the parameter
display area will relate to network parameters – see Tab Bar.

Tab Bar
The Tab Bar displays a set of tabs corresponding to the item selected in the Navigation Tree.

Figure 8 - System/Network tabs

Figure 9 - BIM tabs

Figure 10 - Module tabs

Selecting a tab will present the related set of parameters. See the Control Screen section for
details of the individual tabs.
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Status Bar
The Status Bar lies along the bottom edge of the application window and provides help and
status information to the user at various stages.

Figure 11  Status bar

The left-hand end displays messages that relate to menu and toolbar controls. As each toolbar
icon or menu item is highlighted an explanatory message appears in this area of the Status Bar.
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The Application Controls

This section describes the controls available on the Configurator. These include:

•  Certain Windows controls that the user will need to know,

•  The Application Menus,

•  The Toolbar and

•  The Screens that appear at various stages.

Each is described in detail with recommendations on the best way to use the Configurator.

Windows controls
A range of standard Windows controls is used in the Configurator. To ensure that the user is
familiar with the specific ones that it uses, a brief description is provided here.

Text boxes
A Text box allows the user to enter standard ASCII text characters and numerals - also referred
to as alphanumeric characters.

Figure 12 - A Text box

A text box will accept a certain number of characters. The maximum for each control is defined
in this manual.

If the Configurator Mode is set to Manual or Auto and the current text is changed, the
background colour of the text will change to blue. This indicates that the displayed text is
different to the text currently held in the BIM.

List boxes
Where the user is permitted only a specific range of options for a control, a drop-down list box
is used to make the selection.

Figure 13 - A List box

When the down arrow, on the right of the box, is clicked with the mouse, a list of the available
options is displayed.

Figure 14 - List box showing options

The current selection is highlighted but the user can select another option by clicking on it with
the mouse.

If the Configurator Mode is set to Manual or Auto and the current option is changed, the
background colour of the text will change to blue. This indicates that the displayed option is
different to the one currently held in the BIM.

Up-Down Controls
As their name suggests, these allow the user to vary the value in a field up or down by using the
arrow buttons on the right of the box.

Figure 15 - Up-Down control box
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In addition to using the arrows, a new value can be entered by clicking in the box and editing
the value using the keyboard.

If the Configurator Mode is set to Manual or Auto and the current value is changed, the
background colour of the text will change to blue. This indicates that the displayed value is
different to the one currently held in the BIM.

Check boxes
Check boxes are toggle switches. They can be checked    to confirm a command or state, or
they can be unchecked    for the opposite effect. Click in the box to check or uncheck.

Radio buttons
Radio button controls are also used to select from a range of options. Unlike List boxes, all of
the options are always visible.

Figure 16 - Radio button selection boxes

Only one of the options can be chosen and this is done by clicking on it. The selected option is
indicated by a black dot in the circular box.

If the Configurator Mode is set to Manual or Auto and the option is changed, asterisks will
appear beside the current selection and the previous selection, as shown in the picture above.
This is to indicate that the other selection, and not the current one, is the one held in the BIM.

Greyed-out fields and controls
Sometimes controls are not available to the user under certain conditions. The field or control is
then shown in grey. Examples of a greyed-out text box and list box are provided below.

Figure 17 - Greyed-out fields

These fields cannot be edited but the current value is displayed for information.

The Menus
The menuing system will be familiar to most Microsoft Windows users, especially as some are
shared by many other Windows applications, for example, the File menu, the Windows menu
and the Help menu. Others are more specific to the operation of the Configurator and these are
explained at each step.

Unavailable menu items
Some of the controls will appear greyed-out at certain times or may not be visible at all. This is
because their functions are not applicable at that specific stage. When appropriate, they will
appear, or cease to be greyed-out and will become fully functional.

Some other controls are still under development and will remain “greyed-out” at all times.
These controls are identified in this manual.

Right-click menu items
Quite often, especially when working in the Navigation Tree, see later, a click on the right
mouse button will open a menu for the user.

Tip: Try pointing at an item in the Navigation Tree area and right clicking. The menu that
opens will be specific to the item being pointed at.
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Keyboard shortcuts
Where available, keyboard shortcuts are shown alongside the menu items. These indicate
keyboard methods of achieving the same result as a series of mouse clicks.

Figure 18 - Keyboard shortcuts

The above example shows that, instead of using the mouse to click on the File menu and then
clicking on Save, a simple keyboard method is available. Holding down the “Ctrl” (Control)
key while striking the “S” key will achieve the same result. Users with a preference for using
keyboard shortcuts should find these useful.

File Menu

Figure 19 - File menu

New
This is used to create a new configuration file, add a new BIM or a new I/O module. Move the
mouse pointer over this option and another sub-menu appears which offers: File, BIM or
Module.

New | File
Use this option to create a new configuration file.
See Creating a configuration file on page 43.

New | BIM
This is used to add a new BIM to an existing configuration file.
See Adding a BIM on page 50.

New | Module
This is used to add a module to the node currently selected in the Navigation Tree.
See Adding a module on page 51.

Note: This option is not available if the user is at file level, i.e. with the    symbol
highlighted in the top left corner of the Navigation Tree. Click on a BIM or module symbol to
make it available.
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Open
This enables the user to select a file for opening. See Opening an existing configuration file
on page 44.

Close
This option closes the current configuration file without closing the application. If the file has
been changed but not saved, the user is prompted to save it.

Save
The Save option saves the current file to disk. If the file has not been saved previously, the Save
As… dialog box will appear for the user to choose a storage location. For more details, see
Saving a configuration file on page 45.

Save As…
This option is used when saving a previously unsaved file, or if the user wants to save the
current file to a new disk location. For more details, see Saving a configuration file on page
45.

Print
This provides a printout of the configuration file parameters, which include:

•  BIM attributes

•  Network attributes

•  Module attributes

•  Channel attributes by slot number

Click on Print and a print dialog box will appear so that the printer details can be modified, if
required. Click on OK to execute the print command.

Import configuration
This option enables a user to import a configuration file in .csv or .ssf format. These formats
were standard options for the earlier MTL8450 Configurator.

Recent Files
This part of the File menu shows a list of the most recently opened configuration files. It is a
convenient shortcut to re-open them. Click on a file name to open it.

Exit
Use this to close the 8455 Configurator.

If there are any configuration files open, that have been modified but not saved, a warning
appears, “Save changes to xxxx.cfg?”. Choose Yes, No or Cancel, as appropriate.

Edit Menu

Figure 20 - Edit menu

Undo
This option is reserved for future development.

Cut
This option is reserved for future development.
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Copy
This option is reserved for future development.

Paste
This option is reserved for future development.

Delete
Use this option to delete a BIM or I/O module. See Deleting a BIM in the task section.

Mode
Use this to change the mode of the Configurator. The options are Offline, Manual or Auto.

Figure 21 - Mode selection

The current mode is indicated by a black dot, see Figure 21 above. As an alternative to using the
Edit Menu, the user can click on the Toolbar icons to change the mode.

See Changing the Configurator mode on page 46.

View Menu

Figure 22 - View menu

Toolbar
This is a toggle switch for viewing the Toolbar. When the Toolbar option on the menu has a tick
(a check mark) against it, then the Toolbar will be visible. To change the current state drop
down the View menu and click on Toolbar.

Status Bar
This is a toggle switch for viewing the Status Bar. When the Status Bar option on the menu has
a tick (a check mark) against it, then the Status Bar will be visible. To change the current state
drop down the View menu and click on Status Bar.

Refresh
When in Manual or Auto mode (see Edit menu for details of the modes) this option will cause
the Configurator to update its record of BIM variables.

Configuration Menu
This menu deals specifically with the BIM and requires direct communication; consequently,
the options are available only when the Mode is set to Manual or Auto.

If the Mode is set to Offline, the options will be “greyed out”.
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Figure 23 - Configuration menu

Upload BIM
Use this option to upload the current configuration from a BIM to the Configurator. This option
is not available when in Offline mode. See Uploading BIM parameters on page 45.

Download BIM
Use this option to download the current configuration file to a BIM. This option is not available
when in Offline mode.

Figure 24 - Download configuration options

The check boxes provide both choices and information.

Save configuration to NVM/NSM after download
Check    this to save the configuration to NVM (and NSM if fitted)

Restart BIM after download
Check    this to restart BIM on completion of download

NSM fitted (for information)
This indicates whether there is an NSM fitted to the node and is for information only.

Reset the NSM expected flag
If this option is available, i.e. not greyed out, it indicates that an NSM had previously been
present but has now been removed. Check this box if the NSM is not going to be replaced.

See also Downloading a new configuration to the BIM on page 48.

Force
This option is reserved for future development.

Unforce
This option is reserved for future development.

Set Active Channel
This option is reserved for future development.

Special I/O Commands
This option is reserved for future development.
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Reset
This command performs a software reset on the I/O module or the BIM.

See Resetting the BIM on page 51 and Resetting a module on page 52.

Set Failsafe
Use this command to force a BIM or an I/O module into the failsafe state.

See Setting and clearing BIM failsafe state on page 51 and Setting and clearing I/O module
failsafe state on page 52.

Clear Failsafe
Use this command to take a BIM or an I/O module out of the failsafe state.

See Setting and clearing BIM failsafe state on page 51 and Setting and clearing I/O module
failsafe state on page 52.

Reprogram
Where appropriate, this enables the firmware in the analog I/O modules to be changed.

Figure 25 - Module Firmware Download

BIM
This shows the current BIM type. This field is not editable.

Module
This shows the type of the selected module.

H/W Version
This is the hardware version of the selected module.

Firmware Version
This provides a drop-down list of the module firmware versions available on the system.

Versions
This displays the selected software module with the following fields:

Description
The name of the software module

Current
The version number for the software currently installed in the I/O module

New
The version number of the software indicated by the Firmware Version field.

Status
This indicates whether the software revisions are different:

•  “Not selected” – indicates that the module software version is the same as the one
currently loaded

•  “To be downloaded” – indicates a module version different to the one currently
loaded.
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Select Latest button
This button selects the latest version of the firmware from the list of firmware available.

See also Upgrade analog module firmware on page 55.

Program EEPROM
This option is currently unsupported.

Event Log
Use this option to view the Event Log. The data must be read from the BIM and so this feature
is available only when the Mode is set to Manual or Auto.

Calibrate…
This option is reserved for future development.

View Data in BIM
The user can toggle between this option and the View Data in Database option.

Choose this option to view the data contained in the BIM instead of the data that is currently in
the Configurator database.

The option is available only when the application recognises that the BIM data and the
Configurator database are different.

View Data in Database
The user can toggle between this option and the View Data in BIM option.

Choose this option to view the data currently contained in the Configurator database instead of
the data in the BIM.

The option is available only when the application recognises that the BIM data and the
Configurator database are different.

Show Modules in BIM

Figure 26 - Module details box

This menu item causes the BIM to review the modules it has attached and list them with their
current status. The details are displayed in an on-screen box, shown above. Click the OK button
to remove the box.

Tools Menu

The Tools menu contains options that deal with access to the software and its facilities. Some of
these options are reserved for future development.

Figure 27 - Tools menu
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Security

Figure 28 - Security options

Log on
This enables a registered user to log on without having to close down the application. The name
of the new user appears at the right of the Status Bar and replaces the previous one.

See also The Log on screen on page 4.

Manage User
Use this to edit the password or access level (Group) of an existing user.

Figure 29 - Manage users dialog

User name
A drop down list containing the names of all registered users.

Password
The user’s password. If this is changed then the next field, i.e. Confirm, must also be
completed.

Confirm
This field is used to confirm a new password. This field must contain the same characters as the
password field for the new password to be accepted.

Group
A hierarchy of user levels exists. This enables users to be allocated an access level suited to
their level of responsibility. This ensures that significant changes cannot be made accidentally
by users who are unsure of what they are doing. See Security access levels in Appendix C.
The access categories are as follows:

Table 1 - Security access categories

Access category

Engineer (config.) highest

Engineer (no config.)

User Technician

Read Only lowest

A user must be a Engineer (no config), or above, to create another user.

Create User
Use to add a new user to the site. Define password and access level (Group).

Figure 30  - Create users dialog
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User name
Entry field for name of new user.

Password
The password for the new user.

Confirm
This field is used to confirm the password. This field must contain the same characters as the
password field for the new password to be accepted.

Group
A hierarchy of user levels exists. This enables users to be allocated an access level suited to
their level of responsibility. This ensures that significant changes cannot be made accidentally
by users who are unsure of what they are doing. See Security access levels in Appendix C.
The access levels are as follows:

Table 2 - Security access categories

Access category

Engineer (config.) highest

Engineer (no config.)

User Technician

Read Only lowest

A user must be a Engineer (no config), or above, to create another user.

Security File
This option is for factory use and not required by other users.

Permitted Ids
This option is for factory use and not required by other users.

Environment
This option is reserved for future development.

Options
This option appears only when a configuration file is open and is reserved for future
development.

Window Menu
The Window menu contains two options plus a list of files currently open. The options are used
to arrange on the screen the currently open files.

Figure 31 - Window menu

Cascade
Cascade arranges the open files in layers on top of each other.

Tile
Tile arranges all the open files in a tiled pattern within the application window.

Currently open files
The list shows the names of the files that are currently open. The one currently in view has a
check mark next to it.
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Help Menu
The Help menu has two options, providing access to the Help topics and information on the
application version and contact details.

Figure 32 - Help menu

Help Topics
This provides access to the application help file. This is a standard Windows help file with
Contents, Index and Find options.

About MTL8455
This provides information on the application version and release level. It also provides contact
details for sales and technical enquiries.

The Toolbar
The Toolbar provides shortcut buttons for a number of application controls. The ones marked
with an asterisk ‘*’ are currently not implemented.

Create new configuration file Refresh data (Manual mode only)

Open an existing file Upload configuration from BIM

Save the current file Download configuration to BIM

Print from the current file Set Offline mode

Cut the selected item* Set Manual mode

Copy the selected item * Set Auto mode

Paste item from the Clipboard * Show database data

Add a new BIM Show BIM data

Add a new I/O module Help topics

About the software

The Control Screens
A configuration file contains a range of parameters dealing with networks and communications,
BIMs and I/O modules. This section describes the control screens within the application that
display these parameters. Each screen is selected by clicking on the appropriate tab in the Tab
Bar.

Network and file level
This is the level that is presented when a user opens a configuration file or creates a new one.
Three tabs are presented at the bottom of the application screen.

Figure 33 - Network and File tabs
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File Properties tab
This tab is used to view the physical properties of the configuration file.

Figure 34 - File Properties

Details include its name, size, the type of network it serves, when it was last saved and by
whom. These details are not editable.

File Attributes tab
This tab contains range of fundamental parameters that define the file and the network
parameters.

Figure 35 - Project name and details

Project
This can be used to allocate a name to the Project. It will accept a maximum of 200
alphanumeric characters.

Project Detail
Use this text area for additional project details. It accepts a maximum of 250 alphanumeric
characters.

Figure 36 – BIM type and Auto store

BIM type
This is a non-editable description of the BIM type.

Automatic store to NVM

If this box is checked   , any download to the BIM will be stored to NVM automatically.

Configuration port parameters

Figure 37 - Configuration port parameters

PC Port
This must define the PC COM port that will be connected to the BIM configuration port. The
drop down list offers a choice of COM 1 to COM 8.

BIM Port
This field is used to specify whether the BIM is being configured locally, via the Configurator
Port or remotely, via LAN B.
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Note: When using the Profibus-DP BIM, the field is set automatically to “Local-Configurator
Port” because there is no LAN B.

LAN A Parameters

Figure 38 - LAN parameters

Modbus Profibus

Protocol
This displays the protocol in use. It is not editable because the protocol was defined when the
configuration file was created.

Baud (Modbus only)
This defines the communication rate for LAN A (and LAN B, where available). Choose from
1200 to 115200 baud using the drop-down list.

Parity (Modbus only)
This defines the communications parity bit setting. Choose from None, Odd or Even (default)

Stop Bits & Data Bits (Modbus only)
These fields display the number of stop and data bits used for communications. These fields are
not editable.

BIM Detail tab

This tab provides a list of the BIMs configured in the current file. Each additional BIM added to
the file will have an entry in this list.

The BIM parameters displayed in this list are as follows.

Parameter Meaning

BIM Name The name allocated to the BIM by the user.

LAN A address The address of the BIM on LAN A.

Mode The data refresh mode – Offline, Manual or Auto.

Modified Indicates whether the BIM parameters in the PC database file are
different to those saved in the BIM.

Failsafe Indicates whether the BIM is in failsafe mode, or not.

BIM state OK or Error – indicate current BIM state.

Comms. lost
timeout

The period, in seconds, before the BIM goes into failsafe mode after
losing communications with host.

BIM level
When a BIM is selected in the Navigation Tree the following five tabs appear in the Tab Bar.

Figure 39 - BIM level tabs
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Clicking on a tab will display the named screen.

BIM Properties tab

Figure 40 - BIM properties tab

This tab displays the release information for the software and hardware component parts of the
BIM and also identifies the BIM vendor. The BIM must be on line for the Configurator to read
this information.

A BIM comprises two basic parts, the BIM Core and the MAU; together they form a Composite
which also has its own release level.

BIM Attributes tab
This tab shows the current BIM settings and enables the user to modify some of its key
parameters. It is divided into two areas, BIM Details and Configuration Port Parameters.

BIM Details

Figure 41 - BIM Details

Name
This is an editable text box where the use can enter or edit an appropriate name for the BIM.
The field will accept up to 22 alphanumeric characters.

Type & Product Code
These fields display the type of BIM and its product code.

Event Acknowledge
This indicates that “All” module events will be acknowledged by the BIM. This is not editable.

Halt/Restart Mode
The BIM continually checks its own systems for errors. If it detects a serious error, e.g.
software corruption, then it will adopt the action defined in this field – i.e. Halt or Reset.
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Host Pending TO
This is the Host Pending Timeout. It is a parameter reserved for future development. Its default
value is 10 seconds. The user is advised not to modify this value unless instructed by an MTL
Engineer.

Railbus Pending TO
This is the Host Pending Timeout. It is a parameter reserved for future development. Its default
value is 3 seconds. The user is advised not to modify this value unless instructed by an MTL
Engineer.

Modified
The Configurator displays data that it has uploaded from the BIM but also retains a reference
copy. If the user modifies any of the displayed parameters then the Configurator recognises this
and changes this indicator from No to Yes.

The user will also see parameter changes presented on a cyan (light blue) coloured background.

Mode
While it is connected to the Configurator, the BIM can continue to monitor the I/O modules and
the LAN. The Mode options define when the Configurator will update its variables from the
BIM. See Edit Menu for details of these mode settings.

Configuration Port Parameters

Figure 42 - Configuration port parameters

Baud
This field is used to set the baud rate for the configuration port. The drop-down list box offers a
range of 1200 to 19200 baud.

Parity, Stop Bits & Data Bits
These fields display the other communications parameters for the Configuration port. The
values can not be edited.

Network Attributes tab
This screen enables the user to view the network parameters and edit some of them. The screen
is divided into a number of sections which are sometimes interdependent, i.e. changing a
parameter in one section causes a parameter change in another section.

LAN parameters
This reflects the parameters that have been set for the network but allows the user to define the
address for the BIM. The fields and values displayed depend on the BIM being used.

Figure 43 - LAN parameters

Modbus BIM Profibus BIM
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Protocol

This field is not editable. It is defined when
the configuration file is created.

Protocol

This field is not editable. It is defined when
the configuration file is created.

LAN A Addresses

This field can be modified to change the
address of the BIM on LAN A. Values in the
range 1 to 247 are permitted.

LAN A Addresses

This field can be modified to change the
address of the BIM on LAN A. Values in the
range 1 to 125 are permitted.

Baud

This is the speed chosen for transfer of LAN
data. It is not editable in this view. See File
Attributes tab to change the speed.

IW

This shows the length of the input telegram.
The value displayed is the one uploaded from
the BIM. The user may enter another value to
specify the length of a particular telegram.

Parity

The type of parity checking used – None, Odd
or Even. This field is not editable. See File
Attributes tab to change the parity.

QW

This shows the length of the output telegram.
The value displayed is the one uploaded from
the BIM. The user may enter another value to
specify the length of a particular telegram.

Stop Bits & Data Bits

The number of stop bits and data bits used.
This field is not editable.

LAN B Address

This is the address of the BIM on LAN B. It
will automatically adopt the same address as
LAN A but may be altered by the user if
required. Values in the range 1 to 247 are
permitted. Click on the up or down arrows to
obtain the required setting.

Profibus diagnostics

This displays the type of diagnostic
information currently chosen. The options are:

•  Module status

•  Module status + Channel status

•  Extended diagnostics (Short)

•  Extended diagnostics (Long)

LAN Mode – (Modbus only)

Figure 44 - LAN mode parameters for Modbus BIM

Use this to choose the LAN mode for the BIM at startup. A brief description of each mode is
provided below.

Single LAN
In this mode, all communication is on LAN A. LAN B is disabled. Speeds up to 115.2 kbaud
can be used with this mode. The Config / HMS port is available.

Active Standby
A redundant mode intended for use with a simple pair of duplicate hosts. A maximum baud rate
of 19.2 kbaud is recommended. The Config / HMS port is not available.

Passive Standby
A redundant mode intended for a host pair where Host B is capable of detecting the failure of
Host A, or LAN A, and taking action to assume active control. The selected data rate should not
exceed 38.4 kbaud as there will be some traffic on LAN B. The Config / HMS port is not
available.
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Dual Comms
This permits two hosts to have simultaneous read/write privileges. This is appropriate for
manual control via duplicate MMI/SCADA workstations. As both LANs will be run at the same
speed, the data rate must be limited to 19.2 kbaud.
The Config / HMS port is not available.

Remote Configuration
This mode has a host connected to LAN A while LAN B is used for configuration of the BIM.
The selected data rate should not exceed 38.4 kbaud as there will be some traffic on LAN B.
The Config / HMS port is not available.

LAN B share LAN A port
This mode can, on detection of a primary LAN fault, cause a toggle between LAN A and LAN
B for the main BIM port. The other BIM port can therefore be reserved for activity such as
HART maintenance.

Auto Change Over Timeout
This is also used for the Share LAN mode. This defines the time that the BIM will wait before
changing to the alternative LAN after detecting a communications failure. This will always be
less than the Comms Lost Timeout value to avoid the BIM adopting a failsafe mode. It cannot
be set to a value equal to, or greater than, the Comms Lost Timeout.

Failsafe with Config

Figure 45 - Failsafe with Config parameters

When the BIM is being configured, the lack of LAN traffic can trigger a “Comms Lost” timeout
and cause the BIM to go into failsafe. To overcome this, the insertion of the serial cable, for
local configuration, automatically suspends the BIM’s ability to go into failsafe. For this mode
of operation choose Enter failsafe unless…

On the other hand, the BIM must also be able to operate under normal conditions when it has a
similar cable attached to the configuration port from the 8512 HART Interface module. Under
these circumstances, the BIM’s ability to go into failsafe mode must be available. For this mode
of operation choose Enter failsafe even if…

Note: The BIM will not recognise or communicate with the 8512 module unless this second
option is chosen.

Comms Lost Timeout
This section is used to specify a maximum period of inactivity on the LAN. If there is no LAN
activity within the time interval set here, the BIM will assume a communications failure and
adopt a failsafe mode.

Figure 46 - Comms Lost timeout parameter

Timeout Value
Enter a value or use the up and down arrow buttons to change the current value. The maximum
available in this field is 240 secs (4 mins.).

Disable
To switch off the timeout facility, check    the box.

“Data Mapping” button – Modbus BIM
Click this button to see details of how the I/O data is configured for packed data mapping. For
full details of how packed mapping works see the INM8505 – Modbus BIM Instruction Manual.
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Figure 47 - Modbus Packed Mapping box

Note: This shows only the first eight module positions while the actual display always shows all
32 modules.

To save these details, click the Generate CSV File button and save the file in a .csv format to a
chosen location.

“Data Mapping” button – Profibus BIM
Click this button to see the Profibus address mapping dialog box which displays the input
(IW) and output (QW) bytes and offsets for the modules listed in the navigation tree.

Figure 48 - Profibus address mapping

To save these details, click the Generate CSV File button and save the file in a .csv format to a
chosen location.

BIM Dynamic Data tab
This tab displays various dynamic BIM parameters. It is split into two sections BIM Status and
BIM Error Details. The BIM Status display shows the current settings in the Overall BIM Status
register. The BIM must be on line in order to display the BIM status information.
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BIM Status

Figure 49 - BIM Status

The above image shows details of a Modbus BIM. The Profibus display is a little different. For
more information about these parameters see the Instruction Manual for the BIM.
(INM8502 – for Profibus BIM,  INM8505 – for Modbus BIM)

BIM Error Details

Figure 50 - BIM Error Details

Passthrough Bitmap
When HART data passes through a module this bitmap will display a hexadecimal word that
identifies the module(s) involved.

Scan Overload Bitmap
If a scan overload occurs then this field will display a hexadecimal word that identifies the
module(s) involved.

Module Details tab
This tab displays the basic, but individual, details of up to 32 modules connected to the selected
BIM.

Figure 51 - Module details

 Parameter Meaning

Slot No. The number of the system slot occupied by a module (1 – 32).

Module No. The module’s part number.

Module Type A shorthand description of the type of module.

No. of Chan. The number of channels available in the module.

Primary Scan Rate The primary scan rate in milliseconds.

Modified Whether the module’s parameters have been changed from the
uploaded values.

Module States The current status of the modules (BIM must be on-line, else NA)
See Module Status in appropriate BIM manual for list of states.
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I/O module level
When a module is selected in the Navigation Tree the following five tabs appear in the Tab Bar.

Figure 52 - Module tabs

Module Properties tab
This tab displays the fundamental properties of the selected module and are not editable.

Figure 53 - Module properties

If the Configurator is not able to gather the information, i.e. the BIM and modules are not “on-
line”, then the fields marked with an asterisk ‘*’ in the following table will display as zero.

Parameter Meaning

Module No. The module’s part number.

Module Type A shorthand description of the type of module.

No. of Channels The number of channels available in the module.

Software Version* The release version of the software.

Hardware Version* The release version of the hardware.

Module Serial Number* The module’s serial number.

Passthrough Supported Whether the module can recognise or use messages from the
host that have “passed through” the BIM.

Module Attributes tab
This tab enables the user to view and/or edit the system attributes of the selected module.

Figure 54 - Module details

Module No.
This displays the part number of the module. It is non-editable.



THE APPLICATION CONTROLS

28

Slot Number
This non-editable field shows which of the BIM’s 32 module slots it occupies.

Failsafe Timeout
This field defines the amount of time the module will wait, on loss of BIM communications,
before going in to failsafe. Values between 0 and 25.5 seconds are permitted.

Figure 55 - Scan rates

Scan rates do not define the rate at which a module has its data recovered. The module’s data is
read at the fastest rate possible.

However, the user defined scan rate does serve two useful purposes. First, it defines a worst-
case period between data reads. If this rate is not achieved then a scan overload flag is set.
Secondly, it gives the BIM the means to prioritise data collection. For example, a module with a
scan rate of 40 ms will tend to be read twice as often as a module with an 80 ms scan rate.

A module has a maximum scan rate, which can also be regarded as its minimum period. There is
no point in trying to scan it faster than this, as the module has a minimum period that it requires
to update its field data.

The minimum periods are approximately 6 ms for discrete modules and 20 ms for analog ones.

The module will, therefore, have its data read sometime between the minimum period and the
value set by the user in the scan rate box(es) in this tab. The BIM constantly calculates this
information to avoid reading data too early or too late. The user is advised to keep to the default
values provided for the modules unless there is a valid reason to amend them.

Primary
The “worst case” data update period for the module’s primary field variables. Values from 0 to
65,535 ms are permitted but, initially, the user is advised to use the default value provided.

Secondary (if applicable)
The “worst case” data update period for the module’s secondary variables – such as HART
values or input pulse counter readings. Values from 0 to 65,535 ms are permitted but, initially,
the user is advised to use the default value provided.

Figure 56 - Attributes modified?

Attributes Modified
The Configurator displays data that it has uploaded from the BIM but also retains a reference
copy. If the user modifies any of the displayed parameters then the Configurator recognises this
and changes this indicator from No to Yes.

Module Dynamic Data tab
The Module Dynamic Data tab displays statistics and diagnostic data regarding the performance
of the module. This will be of more interest to the support engineer, who will be looking for
detailed information on the status and performance of the module, than it will be to the process
engineer.

This data is refreshed every 10 seconds (approximately) when in Auto Mode, or when the
Refresh button is clicked if in Manual Mode.
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Module Communication Statistics

Figure 57 - Module Communication Statistics

This shows the individual Module Communication Statistics and displays the number of named
events that have occurred.

Detail Meaning

Successful The number of successful messages received.

Data Transmission
Errors

The number of data transmission errors that have occurred.

Rejected by Module The number of bad messages that the module has rejected

Timeouts The number of timeouts that have occurred.

No New Data The number times “No New Data” has been signalled.

Module Restarts The number of times the module has been restarted.

Device Generic Events The number of device generic events that have occurred.

Device Specific Events The number of device specific events that have occurred.

Entered Failsafe The number of times the module has entered failsafe.

Device Status Register

Figure 58 - Device Status Register

This shows the status of the individual Device Status Register bits. Generally, a Yes status
indicates that the indicated event has occurred and the register bit has been set. A No status
shows that the bit is in its normal (reset) state. Like the Diagnostic Status and the Railbus Status
Registers most of these bits are of no interest to the average user and will be of significance
only in diagnostic applications to a service engineer. The only one of general interest is the
Failsafe parameter which will indicate whether the module is in its failsafe state.
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Railbus Status Register

Figure 59 - Railbus Status Register

This shows the status of the individual Railbus Status Register bits. A Yes status indicates that
the indicated event has occurred and the register bit has been set. A No status shows that the bit
is in its normal (reset) state. Like the Device Status and the Diagnostic Status Registers, most of
these bits are of no interest to the average user and will be of significance only in diagnostic
applications to a service engineer.

Diagnostic Status Register

Figure 60 - Diagnostic Status Register

This shows the status of the individual Diagnostic Status Register bits. A Yes status indicates
that the indicated event has occurred and the register bit has been set. A No status shows that
the bit is in its normal (reset) state. Like the Device Status and the Railbus Status Registers,
most of these bits are of no interest to the average user and will be of significance only in
diagnostic applications to a service engineer.

Module State
This field indicates the current state of the module. The states that might be encountered are
shown in the table below.

Figure 61 - Module State

State Description

EMPTY The slot is empty, it has no configuration
and a module is not detected.

UNTRAINED Set during the first pass of the training
procedure just after the module has been
powered up.

TRAINED Set during the second pass of the training
procedure just after the module has been
powered up.

NO CONFIGURATION Set after training procedure if a valid
configuration is not present.

VENDOR ID MISMATCH Vendor ID of module differs from value
provided during configuration.

DEVICE ID MISMATCH Device ID of module differs from value
provided during configuration.

RUNNING Everything OK. The module is initialised
and working.

FAILED Module is not communicating.

Note: If the LSB contains (07) i.e. FAILED, then the MSB will contain a diagnostic value,
otherwise the MSB will be 0x00.
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Figure 62 - Last Comms Error

Last Comms Error
This field indicates the current state of the module. This information is for factory use only.
Consult the BIM manual for some further details.

Figure 63 – Clear Counters button

Clear Counters button
Click on this button to zero the counts in the Module Communication Statistics registers. The
effect can be seen in the display (top left of this tab display). The action of clicking on this
button also initialises the Actual Scan Rate field (see below). Note, this button is not provided
when the Configurator is in “Offline” mode.

Figure 64 - Actual Scan Rate

Actual Scan Rate
This displays the average rate at which the selected module has been scanned since the last
refresh of the Configurator data. The field is normally greyed-out until the Clear Counters
button is clicked (see above). Note, this field is not provided when the Configurator is in
“Offline” mode.

Channel Attributes tab
The Channel Attributes tab enables the user to edit the channel variables. For example; channels
can be allocated a tag name, or they can be made active or inactive via this tab. Alarm
thresholds can be defined here and individual states, or values can be set for channels that are
forced into a failsafe condition by a comms. failure.

To simplify editing, many of the attributes can be modified with a simple check box, a drop-
down list or increase/decrease buttons. Occasionally, as in tag names, the full entry will require
a small degree of typing but generally the operations can be performed with just a mouse.

The range of options vary with the module type:

•  Discrete input modules

•  Discrete output modules

•  Analog input modules

•  Temperature input modules

•  Analog output modules

•  Pulse input modules

Discrete input modules
For each channel, the following attributes can be edited.

Channel tag name
A name for the channel or its function can be entered here. Up to 22 ASCII text characters can
be entered in this field.

Active
This is a toggle control that makes the channel active or inactive. Check the box    to activate
the channel, or uncheck it    to make it inactive.

Polarity (2/1 modules only)
This field determines whether the Latch function latches to a high state or a low state. See
Latch.

Latch
If this function is enabled then, if the input goes from low to high, it will stay at that level.
Select from Enabled (latch facility ON) or Disabled (no latch facility) using the drop-down box.

Note: 2/1 modules also have the option of choosing a high or a low latch state using the
Polarity field.
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LFD (2/1 modules only)
This allows the Line Fault Detect facility to be switched On or Off. When switched On, the
module will detect a channel that has an open circuit or short circuit fault on the device loop and
set a flag to inform the BIM.

Failstate Value
This field determines the value the BIM will display to the host if the module fails or goes into
failsafe mode. The choices are On (high), Off (low) or Hold Last Value, which maintains the
input at the last valid input value.

Counter Enable
Check this box    to switch the input counter on or uncheck it    to switch it off .

Filter
This defines the delay parameter for the input de-bounce filter. Three options are available:

•  None – No delay

•  Fast – 22 ms settling time before accepting the input value.

•  Slow – 258 ms settling time before accepting the input value.

Discrete output modules
For each channel, the following attributes can be edited.

Channel tag name
A name for the channel or its function can be entered here. Up to 22 ASCII text characters can
be entered in this field.

Active
This is a toggle control that makes the channel active or inactive. Check the box    to activate
the channel, or uncheck it    to make it inactive.

Failsafe Value
This field determines the value the output will adopt if the module fails or goes into failsafe
mode. The choices are On (high), Off (low) or Hold Last Value, which maintains the output at
the last value it was given by the host.

Operation mode
This field defines the type of output from the DO module.

•  Discrete

•  Single Pulse – Static

•  Continuous Pulse – Static

•  Continuous Pulse – Dynamic (8215-DO-IS only)

From the above it can be seen that three basic types are available, discrete, single pulse and
continuous pulse. Discrete means that the BIM signals an On or Off condition on demand.
Single Pulse mode has a “single shot - On” action with a duration set by the On Time field.
Continuous Pulse provides a continuous stream of pulses defined by an On Time and a Period.

The Static and Dynamic options for the Continuous pulse modes define the behaviour of an
output when entering or leaving the failsafe or inactive states.

Static mode

When the module enters failsafe, or is made inactive, then pulse mode is disabled, the channel is
configured as a latched output and is driven to its failsafe value. The module must then be re-
initialised by the BIM before it can be restored to an operational condition.

Dynamic mode

If the module enters failsafe, the output is driven to its failsafe value. If it is made inactive, the
output is turned Off (i.e. de-energised). On leaving the failsafe or inactive state, the channel will
resume operation with the previous configuration and output.

LFD (2/1 modules only)
This allows the Line Fault Detect facility to be switched On or Off. When switched On, the
module will detect a channel that has an open circuit or short circuit fault on the device loop and
set a flag to inform the BIM.



THE APPLICATION CONTROLS

33

Period
This defines the time between the leading edges of the pulses for the continuous pulse mode. It
can not be less than the On Time (see next) and any attempt to do so creates a warning from the
software. The period can be set in 2 ms intervals anywhere between 4 ms and 130,000 ms.

On Time
This defines the duration of the On pulse from 2 ms upwards. The On Time must always be set
to at least 2 ms less than the Period; a warning will be displayed if the user tries to set a value
that violates this. For AC modules, see also the following note.

Note: AC discrete output modules can be triggered On or Off only during a zero crossing of the
AC waveform. The minimum On time of a pulse is therefore limited to half the total period of
the AC waveform used.

Analog input modules
Channel tag name
A name for the channel or its function can be entered here. Up to 22 ASCII text characters can
be entered in this field.

Active
This is a toggle control that makes the channel active or inactive. Check the box    to activate
the channel, or uncheck it    to make it inactive.

Sensor Type (8230-AI-IS only)
Choose “Volts” or “Potentiometer” from the drop down list

HAlarm, LAlarm (HHAlarm  and LLAlarm)
These fields enable the user to set threshold values for the alarms (High and Low). Some
modules have additional alarms (High-High and Low-Low) set at more extreme limits. All of
these can be changed by typing a new value, or by using the up and down adjustment arrows on
the right-hand edge of the field.

With the exception of the 8230-AI-IS module, the minimum and maximum values are -25% and
131.25%, respectively.  Attempts to exceed these, or to give a low alarm a value greater than a
high alarm, will produce a warning from the software.

The 8230-AI-IS has potentiometer and voltage input options and the high and low alarm ranges
for these are:

•  Potentiometer - 0% and 100%

•  Voltage input - 0 to 12.5 V

Alarm Deadband
This defines a “dead”, or hysteresis, band which prevents the alarm from cycling on and off
when a rapidly varying (i.e. noisy) signal crosses the alarm threshold. The value should be set
large enough to prevent local noise levels from causing this problem. This value applies to all
four alarms.

With the exception of the 8230-AI-IS module, the minimum and maximum values are 0 % and
156.25 %, respectively. The 8230-AI-IS has potentiometer and voltage input options and the
minimum and maximum values are 0% and 100%.

Deadzone
If the input signal measured by the module changes from its last reading, the “New Data” flag
will be set. If however, the change is not significant to the control process, then this event will
cause un-necessary data traffic to the BIM and the host. The Deadzone parameter is used to set
a minimum signal-change value. If the input signal change is less than this value, it will not be
signalled to the BIM.

With the exception of the 8230-AI-IS module, the setting range can be any where between 0
and 156.25% of the analog range. A zero value will cause every change to be signalled to the
host, while a high value will de-sensitise the system. The setting should be made with regard to
optimum control without excessive LAN traffic.

The 8230-AI-IS module has a deadzone range of 0% and 100% for volt or potentiometer input.

Filter time
This defines the bandwidth of a low pass input filter. Filter times between 50 milliseconds and
60 seconds are available.
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A low value, like 50 milliseconds, will make the system sensitive to the smallest changes in
input, while the 60 second value will smooth out minor changes. To switch off the filtering
completely, choose a ‘0’ value, which is also the default.

Open Circuit  (8230-AI-IS only)
Use this field to define the value that gets reported to the BIM if the sensor goes open-circuit.
Select from: Upscale, Downscale or None.

Compensation (8230-AI-IS only)
When “Potentiometer” is selected in the Sensor Type field this field becomes active and is used
to compensate for lead resistance. The value entered should be expressed as a percentage of the
potentiometer’s total resistance value.

Failstate Condition
This provides a choice of states that the BIM can report to the host in the event that the module
fails or goes into failsafe mode. The drop-down list box offers four options:

Option Effect

Hold Last Value Report to the host the same input value that occurred immediately
before the failure or the adoption of a failsafe state.

Failstate Value Report to the host the value set in the Failstate Value field.

High Report to the host the highest possible value.

Low Report to the host the lowest possible value.

Failstate Value
When the Failstate Condition (see above) has been set to Failstate Value, this field defines the
value the input will adopt. With the exception of the 8230-AI-IS module, the value can be set as
a percentage between 0 to 131.25 %, of the analog input range.

The 8230-AI-IS has potentiometer and voltage input options and the failstate value ranges for
these are:

•  Potentiometer - 0% and 100%

•  Voltage input - 0 to 12.5 V

HART Comms (HART modules only)
The pass-through of HART communications for the module can be Enabled or Disabled with
this field.

Profibus HART enable (Profibus HART modules only)
Check any of the four boxes to select the HART variables required from the channel. Any
checked box enables the HART Comms field for that channel.

Note: Be aware that each selected variable adds 2 words (32 bits) to the Profibus telegram.

Temperature input modules
Channel tag name
A name for the channel or its function can be entered here. Up to 22 ASCII text characters can
be entered in this field.

Active
This is a toggle control that makes the channel active or inactive. Check the box    to activate
the channel, or uncheck it    to make it inactive.

Sensor type
Use the drop-down box in this field to define the sensor type. The temperature range depends
upon the one selected.

Wires
This applies to RTD modules (8x06) only. Use it to choose the number of wires – 2, 3 or 4 – for
the RTD sensor.

HAlarm and LAlarm
These fields enable the user to set threshold values for the upper alarm (High) and the lower
alarm (Low). Change the value by entering a new one – in mV or °C - or by using the up and
down adjustment arrows on the right-hand edge of the field.
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The maximum and minimum values depend upon the range of the sensor being used (see
Sensors above) and will therefore need to be modified if the sensor is changed. Attempts to
exceed these, or to give one of the low alarms a value that exceeds one of the high alarms will
produce a warning from the software.

Deadzone
If the input signal measured by the module varies from its last reading then this will cause the
“New Data” flag to be set. If the change is insignificant to the control process, then the event
causes un-necessary data traffic to the BIM and the host. This field is used to set a minimum
signal-change value. If the input signal change is less than this Deadzone value, it will not be
signalled to the BIM.

The setting range can be anywhere between 0 and 100%.

Filter
The filter is used to reduce minor fluctuations in the input values. The options are:

•  Disabled

•  Average of Two Readings

•  Running Average

The Two Reading Average is derived from the current reading and the previous reading. The
Running Average uses the current reading and the last filter output.

Open Circuit
Use this field to define the value that gets reported to the BIM if the sensor goes open-circuit.
Select from: Upscale, Downscale or None.

Compensation
For thermocouple and mV modules, the options to use the internal or remote CJCs are On or
Off.

When using RTD or ohmic inputs, the resistance of the compensation wires can be entered in
the field.

Failstate Condition
This provides a choice of states that the channel input value can adopt in the event that the
module goes into failsafe mode. The drop-down list box offers four options: Hold Last Value,
Failstate Value, High and Low. The Failstate Value can be set with the next field.

Failstate Value
When the Failstate Condition (see above) has been set to Failstate Value, this field defines the
value the input will adopt. The value can be anywhere from 0 to 100 % of the analog input
range.

Analog output modules
Channel tag name
A name for the channel or its function can be entered here. Up to 22 ASCII text characters can
be entered in this field.

Active
This is a toggle control that makes the channel active or inactive. Check the box    to activate
the channel, or uncheck it    to make it inactive.

Failsafe Condition
This defines the output state in the event of the module going into failsafe mode. There is a
choice of Hold Last Value or Failstate Value. The Failstate Value can be set with the next
field.

Failsafe Value
When the Failstate Condition (see above) has been set to Failstate Value, this field defines the
value the output will adopt. The value can be anywhere from 0 to 100 % of the analog output
range.

Initial Output Value
This is a specific and definable value that is written to the output when the module state changes
from inactive to active or when the module is first initialised. The range is 0 to 100%.

HART Comms  (HART modules only)
The pass-through of HART communications for the module can be Enabled or Disabled with
this field.
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Note: The passthrough is not fully enabled until a value is set for the Secondary Scan Rate in
the Module Attributes tab – a warning is provided on screen if the value has not been set.

HART Slot0/1/2/3  (HART modules only)
Check the box    to activate the HART variable, or uncheck it    to make it inactive.

Slot0/1/2/3 Code  (HART modules only)
Enter the required HART code for the specific variable.

Profibus HART enable (Profibus HART modules only)
Check any of the four boxes to select the HART variables required from the channel. Any
checked box enables the HART Comms field for that channel.

Pulse input modules
Channel tag name
A name for the channel or its function can be entered here. Up to 22 ASCII text characters can
be entered in this field.

Active
This is a toggle control that makes the channel active or inactive. Check the box    to activate
the channel, or uncheck it    to make it inactive.

H Alarm and L Alarm
These fields enable the user to set threshold values, in Hz, for an upper alarm (High) and a
lower alarm (Low). These can be changed by typing a new value, or by using the up and down
adjustment arrows on the right-hand edge of the field.

The maximum and minimum values are 100,000 Hz and 0 Hz.

Acceleration Alarm
Choose from the drop down list to disable or enable an alarm for acceleration or deceleration.

Cycle/sec2
Set an integer alarm value between 1 and 100,000. For negative acceleration values, use
positive value and change Acceleration Alarm to Deceleration.

Failstate Value
This field defines the value the input will adopt in the event of the module entering the failsafe
mode. The maximum value is 100000 Hz.

Alarm Deadband
This defines a “dead”, or hysteresis, band which prevents the alarm from cycling on and off
when a rapidly varying (i.e. noisy) signal crosses the alarm threshold. The value should be set
large enough to prevent local noise levels from causing this problem.

The maximum and minimum values are 100 kHz and 0 Hz, respectively.

Filter
The filter sets an upper limit to the input pulse bandwidth. Choose from the drop-down list
which offers: 100, 20, 5 and 1 kHz.

Frequency Range
This defines the input resolution of the module. The available settings are 5, 10, 30, 50 and 100
kHz bandwidth. Use the drop-down box to select the range required. The maximum bandwidth
of 100 kHz is the default value.

Sample Rate
This is related to frequency, as the pulse rate is calculated by measuring the time between
pulses. The frequency is measured from one edge to the next occurrence of the same edge on
the next pulse.

The frequency value is averaged over the most recent measurements. The number of
measurements is configured using the Sample Rate parameter. The available options range from
20 ms to 200,000 ms.

OC Response
Each channel can be configured to detect an open or short circuit condition in the field wiring.
This fault is signalled by setting the Open Circuit or Short Circuit bit in the Alarm Status byte.

This field defines whether the frequency value should be set to the top of the range (plus full-
scale) or the bottom of the range (minus full-scale) on detection of either fault condition. Off
disables these responses.
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Missing Pulse Multiplier
If no input pulse is detected for a time period, then a Missing Pulse Alarm is signalled. The
value chosen for this parameter is multiplied by the Sample Rate to arrive at a timeout figure.
The maximum multiplier value that can be used is 255. Setting the figure to 0 disables the
missing pulse alarm.

Counter Preset Value
This field is used to set a count value. In the case of an upward count the counter will count up
to this value. In the case of a downward count it will be the value from which the count starts.
The maximum value for this preset is 2,147,483,647 (32-bit signed integer).

Counter Direction
This field defines whether the counter should increment (Up) or decrement (Down).

Quadrature Enabled
When checked, this will combine the two input channels into a quadrature pair that are capable
of sensing the direction of rotation.

Polarity
This defines whether the pulse rate is measured from the rising or falling edge of the pulse.

DI Enabled
This field is used to enable, or disable, the Discrete Input facility on Channel 1. There is no DI
input on Channel 2.

Counter Enabled
When this is enabled, the input counter will increment for each pulse registered. When disabled,
the input counter will stop incrementing and retain its last value.

Channel 1
These fields define the input parameters for Channel 1 and the function type for the DO.

Sensor
Select from the following input sensors: NAMUR1, Voltage input, Current input, Switch input
or Hall.

Threshold
This applies only to the Voltage and Current input sensor types. The threshold value for the
sensor can be set from the dropdown list.

DO function
This field is used to define the DO output. The options are: Disabled, High/Low Alarm,
Acceleration Alarm, Preset Counter Value Reached, Quadrature and Scaled Pulse
Retransmission.

Retransmission Scale Factor
This defines the division factor for the Scaled Pulse Retransmission. Choose values from 1 to
256.

Channel 2
These fields define the input parameters for Channel 2 and the function type for the DO. It does
not have the DO facilities of Quadrature and Scaled Pulse Retransmission that are found for
Channel 1.

Sensor
Select from the following input sensors: NAMUR1, Voltage input, Current input, Switch input
or Hall.

Threshold
This applies only to the Voltage and Current input sensor types. The threshold value for the
sensor can be set from the dropdown list.

DO function
This field is used to define the DO output. The options are: Disabled, High/Low Alarm,
Acceleration Alarm and Preset Counter Value Reached.

Channel Dynamic Data tab
The Channel Dynamic Data tab displays the current state of the module variables for each
channel.

The channels are numbered, have a user defined Tag Name and an indication of whether the
channel is currently Active. After that, the variables displayed depend on the module selected.
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Discrete Input modules
Module types:

•  8107-DI-DC •  8111-DI-AC

•  8108-DI-DC •  8112-DI-AC

•  8109-DI-DC •  8113-DI-AC

•  8110-DI-DC •  8114-DI-AC

•  8121-DI-DC •  8220-DI-IS*

•  8122-DI-DC

*8-channel or 16-channel depending on field terminal used

In addition to Tag Name and Active, the following channel fields are presented.

Value
This field displays whether the channel is On (high) or Off (low).

Counter
This displays the contents of the input counter.

LFD (2/1 modules only, i.e. 82xx )
Line Fault Detect. This indicates whether the channel has detected a line fault.

Forced?
This indicates whether the input has been forced to its current value.
Note: Forcing is a commissioning tool that enables the engineer to force a channel to a specific
state and then check that the channel complies.

Discrete Output modules
Module types:

•  8115-DO-DC •  8116-DO-AC

•  8117-DO-DC •  8118-DO-AC

•  8215-DO-IS

In addition to Tag Name and Active, the following channel fields are presented.

Output value
This displays the value currently being output. On (high) or Off (low).

Readback value
This displays the output value that the module is reporting back to the BIM.
On (high) or Off (low).

LFD
Line Fault Detect. This indicates whether the channel has detected a line fault.

Forced?
This indicates whether the channel has been forced to its current value.
Note: Forcing is a commissioning tool that enables the engineer to force a channel to a specific
state and then check that the channel complies.

Analog Input modules
Module types:

•  8101-HI-TX •  8201-HI-IS

•  8103-AI-TX •  8119-VI-05

•  8230-AI-IS

In addition to Tag Name and Active, the following channel fields are presented.

Value (mA)
This displays the analog input value (mA or V) that the input is currently registering.

Alarms – High-High, High, Low, Low-Low
Each of the alarm fields will indicate whether the input has crossed their individual thresholds.
Yes (alarm condition) or No (no alarm).
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A/d Error
Displays whether an Analog to Digital converter error has been detected.
Note: If this is indicated, the module should be returned to MTL.

Forced?
This indicates whether the channel has been forced to its current value.
Note: Forcing is a commissioning tool that enables the engineer to force a channel to a specific
state and then check that the channel complies.

If the analog input module has HART capabilities then, in addition to the basic analog input
fields, the following channel fields will be displayed to show the current state of the HART
variables.

HART Comms Error (HART modules only)
This field indicates the occurrence errors in the HART communications. Yes (errors have
occurred) or No (no errors).

HART No Comms (HART modules only)
This field indicates that the HART communications have failed. Yes (failure) or No (OK).

HART Status Change (HART modules only)
This field indicates whether a change has occurred in the HART status - Yes or No.

HART Device Status (HART modules only)
This displays the second byte of the HART status word - also called the response code - which
contains the operational state of the field or slave device. The hex byte that is displayed may be
a combination of some of the following bits.

Bit # Name

7 Field device malfunction

6 Configuration changed

5 Cold start

4 More status available

3 Analog output current fixed

2 Analog output saturated

1 Non-primary variable out of limits

0 Primary variable out of limits

HART Response (HART modules only)
This displays the first byte of the HART status word - also called the response code - which
may contain a response to a host command. Bit 7 of this byte will be 0 to indicate that it is a
command response and not a communications error. The other six bits (0 – 6) will be decoded
as a hex number and displayed in this field. Some of the hex values are tabulated here but others
will require interpretation from more comprehensive HART literature.

Value Description

0 No command-specific error

1 (Undefined)

2 Invalid selection

3 Passed parameter too large

4 Passed parameter too small

5 Too few data bytes received

6 Device-specific command error

7 In write-protect mode

10 Access restricted

20 Device is busy

40 Command not implemented

HART Prim, Sec, Tert and 4th Var (HART modules only)
These fields display the primary, secondary, tertiary and fourth HART variables. When the
value is numerical it is displayed. If the returned information is not a number, then NAN is
displayed.
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Temperature Input modules
Module types:

•  8105-TI-TC •  8205-TI-IS

•  8106-TI-RT •  8206-TI-IS

In addition to Tag Name and Active, the following fields are presented.

Value
Displays the current input value in:

•  mV for thermocouple type - TC

•  Ω  for RTD type - RT  or

•  degrees Celsius – either type.

H Alarm and L Alarm
These alarm fields will indicate whether the input has crossed their individual thresholds. Yes
(alarm condition) or No (no alarm).

Open Sensor
Indicates whether the sensor for the channel has an open circuit fault.

A/d error  (8205/6 only)
Displays whether an Analog to Digital converter error has been detected.
Note: If this is indicated, the module should be returned to MTL.

CJC error  (8205/6 only)
Indicates that either of the (two) cold junction compensation (CJC) elements in the field
terminal has gone open circuit or out of range.

Forced?
This indicates whether the channel has been forced to its current value.
Note: Forcing is a commissioning tool that enables the engineer to force a channel to a specific
state and then check that the channel complies.

Analog Output modules
Module types:

•  8102-HO-IP •  8202-HO-IS

•  8104-AO-IP •  8204-AO-IS

Output value (mA)
This displays the value of the current (mA) being output.

Readback value (mA)
This displays the value of the current (mA) being reported back to the BIM.

Output Open
This indicates whether the channel output’s field wiring is open circuit.

HART Response (HART modules only)
This displays the first byte of the HART status word - also called the response code - which
may contain a response to a host command. Bit 7 of this byte will be 0 to indicate that it is a
command  response and not a communications error. The other six bits (0 – 6) will be decoded
as a hex number and displayed in this field. For details of the responses see the Analog input
module section.

Forced?
This indicates whether the channel has been forced to its current value.

Note: Forcing is a commissioning tool that enables the engineer to force a channel to a specific
state and then check that the channel complies.

If the analog output module has HART capabilities then, in addition to the basic analog output
fields, the following channel fields will be displayed to show the current state of the HART
variables.

HART Comms Error (HART modules only)
This field indicates the occurrence errors in the HART communications. Yes (errors have
occurred) or No (no errors).
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HART No Comms (HART modules only)
This field indicates that the HART communications have failed. Yes (failure) or No (OK).

HART Device Status (HART modules only)
This displays the second byte of the HART status word - also called the response code - which
contains the operational state of the field or slave device. To interpret the status message, see
the Analog input module section.

HART Status Change (HART modules only)
This field indicates whether a change has occurred in the HART status - Yes or No.

Diags. in process (HART modules only)
This indicates whether the device is undergoing device-specific diagnostics by a maintenance
program connected to the system.

HART Prim, Sec, Tert and 4th Var (HART modules only)
These fields display the primary, secondary, tertiary and fourth HART variables. When the
value is numerical it is displayed. If the returned information is not a number, then NAN is
displayed.

HART Dev Var Slot0, Slot1, Slot2 and Slot3 (HART modules only)
Some field devices have an additional four HART variables. These fields display the HART
codes for such variables.

Pulse Input modules
Module type:

•  8123-PI-QU •  8223-PI-IS

Alarms – High, Low, Acceleration and Missing Pulse
Each of the alarm fields will indicate whether the input has crossed their individual thresholds.
Yes (alarm condition) or No (no alarm).

LFD
Line Fault Detect. This indicates whether the channel has detected a line fault.

Open Circuit and Short Circuit
These indicate whether the channel’s field wiring is open circuit or has a short circuit.

DI State
This shows the current state of the input – high (1) or low (0).

Frequency
This field displays the current input pulse frequency.

Acceleration
This field displays the current acceleration - based on the rate of change of input frequency.

Quadrature Forward and Reverse
These fields indicate whether the quadrature measurement is indicating a forward or reverse
motion.

Preset Count Reached
This field displays whether the counter has reached the value set by the user.

Counter
This field displays the current value of the 31-bit counter. The counter also has a sign bit to
recognise when a downward count has passed zero.
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Tasks (How to…)

This section of the manual deals with a range of tasks that a user is likely to perform with the
Configurator. It is broken down into the following categories:

•  Security tasks

•  Configuration tasks

•  BIM tasks

•  I/O module tasks

Select from these categories for the function required.

Security tasks

Log out one user and log in another
Click on Tools | Security | Log on… to display the Log on dialog box.

Figure 65 - Log on dialog

Enter the name of the user being logged on followed by their password.

The previous user is now logged out and the privileges of the new user become current.

Creating new users
Click on Tools | Security | Create User… to display the Create User dialog box.

Figure 66 - Create user dialog

Enter a name for the new user.

Enter a password for the user and type it again in the Confirm text box. The password and the
confirmation will appear as a series of asterisks ‘*’. This is to ensure that an onlooker cannot
read the password being typed. If the password entered in the confirm field is not the same as
the one in the password field, a message box will inform the user of this fact and the  names
must be re-entered.

Click on the down arrow to the right of the drop-down list and choose a security Group – see
page 16 for a description of group levels and associated privileges.
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Removing a user
To delete a user from the access list. Click on Tools | Security | Manage User … to display the
Manage user dialog box.

Figure 67 - Manage user dialog

Select the User name to be removed from the drop down list. Click the Delete button to remove
that user. Choose another name to delete, or click OK or Cancel button to close the dialog box.

Changing a user’s group
A user’s group, i.e. access level, may be changed at any time by  a user who has the authority to
do so.

Click on Tools | Security | Manage User to display the Manage user dialog box. See  Figure
67 above.

First, choose the user who’s access level needs to be changed. To do this, click on the down
arrow to the right of the User name field. Choose the user from the drop-down list that appears.

Next, click on the down arrow to the right of the Group field and choose the access level
required. Click OK to confirm the change.

Changing a password
Click on Tools | Security | Change User to display the Change user dialog box. See Error!
Reference source not found. above.

First, choose the user who’s password needs to be changed. To do this, click on the down arrow
to the right of the User name field. Choose the user from the drop-down list that appears.

Type the new password in the Password field and the Confirm field. Click OK to confirm the
change.

Configuration tasks

Creating a configuration file
A configuration file can be created from a clean page, or from a file previously created for the
earlier 8450 Configurator. To use a configuration file from the earlier 8450 Configurator see
Importing an 8450 Configuration File.

To create a completely new file, either click on the New button on the Toolbar or use the New
option on the File menu.

A dialog box appears offering a choice of two BIM types.

The configuration file is based upon the type of LAN that the system will use, i.e. Modbus or
Profibus-DP and so the user must select the BIM that suits the LAN protocol.

Figure 68 - BIM selection dialog box

Click on the required BIM type then the OK button. This creates a new file with the chosen
network protocol. To add nodes to the network, one or more BIMs need to be created. See
Creating a BIM for details.
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Importing a file created with the 8450 Configurator
The 8455 permits the importation of configuration files previously used with the earlier 8450
Configurator. Users of the 8450 Configurator can therefore re-use their original files.

(The user is referred to MTL Technical Service Note 101 for further information on the upgrade
of Configurator firmware from V1.xx to V2.xx)

There are two types of file that can be imported:

File type Description

CSV files These are configuration files that were created in a text editor or in a
spreadsheet and saved in “comma separated value” format for the 8450
Configurator.

SSF files This type of file was created by the earlier 8450 Configurator from a .csv
file and could be downloaded direct to the BIM.

Importing the file
The user is advised to refer to MTL Technical Service Note before

Click the Import Configuration option on the File menu and an Open dialog box appears in
order to select the file.

Figure 69 - Open dialog for importing earlier files

Use the Files of type drop-down list to select .csv or .ssf file format.

From the files listed in the dialog box, click on one to select it and then click Open.

Opening an existing configuration file
Click on the File Menu and select the Open option. The Open dialog box appears to permit
selection of the location and file required.

Figure 70 - File Open dialog box
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The default file location is the folder that contains the application files. The default
configuration file type has a “.cfg” file extension as shown in the Files of type list box above.
The offered alternative to this is “All files”.

•  Choose the required file from the list of files shown and click the Open button.

Note: If the file required has been opened recently it may be listed in the Recent Files section of
the File menu. If so, click on the file name to open it.

Saving a configuration file
Click the Save the current file button on the Toolbar or use the Save option on the File Menu.

If the file has already has a name then the Configurator will instantly save it. If it does not yet
have a file name, or the file was created with an earlier version of the 8455 Configurator, then
the Save As dialog box appears.

Figure 71 - Save As dialog box

Use the Save in list box to find a suitable save location and enter a name for the file in the File
name text box. It is not necessary to enter the file extension, i.e. .cfg, as this will be added to
the file automatically. An existing file will be overwritten by the current one if a file name is
chosen from the ones displayed. Click the Save button to finish.

Setting up the Configurator for a “local” BIM
If the BIM is not located in a hazardous area, or if it is a Profibus BIM being configured in a
safe area, a PC running the Configurator can be connected directly to the configuration port on
the BIM. See page 3 for the connection cable details.

•  Connect the PC to the BIM via the cable and power-up the BIM/system.

•  Start the Configurator and create, or open, a configuration file that has the same protocol as
the BIM that is to be configured.

•  Click on the Network icon in the Navigation Tree and then the File Attributes tab.

•  In the Configuration Port Parameters section of this screen, set the PC port field to match
the COM port used on the PC, then choose the Local - Configurator Port option for the
BIM Port field.

•  Click on the Auto Mode button on the Toolbar to establish communication with the BIM.

Setting up the Configurator for a “remote” Modbus BIM
If a Modbus BIM is in a remote location, a PC running the Configurator can be connected to the
BIM via LAN B.

Configuring an existing system BIM
•  Start the Configurator and create, or open, a configuration file that has the same protocol as

the BIM that is to be configured.

•  Click on the BIM icon in the Navigation Tree and then the Network Attributes tab.

•  Choose Remote Configuration in the LAN Mode section of the screen.

•  Click on the Network icon in the Navigation Tree and then the File Attributes tab.



TASKS

46

•  In the Configuration Port Parameters section of this screen, set the PC port field to match
the COM port used on the PC, then choose the Remote – LAN B option for the BIM Port
field.

•  Click on the Auto Mode button on the Toolbar to establish communication with the BIM.

Configuring a new BIM
If the remote BIM is brand new and has not been configured previously:

•  Start the Configurator and create, or open, a configuration file that has the same protocol as
the BIM that is to be configured.

•  Click on the BIM icon in the Navigation Tree and then the Network Attributes tab.

•  Choose Remote Configuration in the LAN Mode section of the screen.

•  Set LAN B address to 126 to match the default address of the new BIM

•  Click on the Network icon in the Navigation Tree and then the File Attributes tab.

•  In the Configuration Port Parameters section of this screen, set the PC port field to match
the COM port used on the PC, then choose the Remote – LAN B option for the BIM Port
field.

•  Click on the Auto Mode button on the Toolbar to establish communication with the BIM.

Uploading BIM parameters
This action transfers a copy of the BIM’s configuration parameters into the Configurator
database.

In order to upload the parameters from a BIM:

•  an operational communications link must be present between the BIM and the Configurator

•  a new, or existing, configuration file must be open in the application window

•  the configuration file must contain an icon for the BIM

Note: The BIM in the configuration file must be of the same type as the BIM whose parameters
are to be uploaded. To check the type, see the BIM Attributes window.

To upload the configuration information from a BIM, either the BIM or one of the I/O modules
attached to it must be selected in the Navigation Tree, then:

•  Click the Upload icon on the Toolbar; or use the Upload BIM option on the Configuration
menu; or right click on the BIM or one of its I/O modules and select Upload BIM

•  A box appears on screen to indicate the progress of the upload. When this reads 100%
completed, click the OK button to finish. The Configurator now contains a copy of the
BIM’s configuration data in its database.

•  A message box appears on screen which shows the progress of the upload. When the
upload box displays “Transmission completed”, click the OK button on the box to finish
the process.

Changing the Configurator mode
While it is connected to the Configurator, the BIM can continue to monitor the I/O modules and
the LAN. The Mode options define when the Configurator will update its variables from the
BIM.

The Configurator has three possible modes: Offline, Manual and Auto. The default mode is
Offline.  Choose one of the following modes as required.

Offline
When Offline the Configurator does not obtain any updated information from the BIM.

Manual
Manual mode allows the user to update the Configurator with BIM information on demand. To
obtain an update use the Refresh option in the View menu.

Changes to parameter values in the configuration file will cause the background colour of the
parameter to change to blue/cyan. This indicates a difference between the value held in the BIM
and the current database value.
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Auto
With the mode set to Auto, the Configurator obtains regular updates from the BIM. These occur
approximately every 10 seconds.

Changes to parameter values in the configuration file will cause the background colour of the
parameter to change to blue/cyan. This indicates a difference between the value held in the BIM
and the current database value.

To change the mode, either:

•  Click on the Offline, Manual or Auto button on the Toolbar or

•  Right click on the Network icon (or a BIM icon) in the Navigation Tree, choose Mode
from the options and then select Offline, Manual or Auto.

Setting LAN parameters
The baud rate and the parity settings are the only parameters that may be altered for the LAN
port(s), the number of data bits and stop bits are fixed. With two LANs, both must be operated
at the same speed and setting LAN A parameters will also define the LAN B parameters.

To modify the LAN parameters:

•  Click on the Network icon and choose the File Attributes tab in the Tab Bar.

•  In the LAN A Parameters section, choose the Baud and Parity settings from those available
in the drop-down list boxes.

Note: With Modbus BIMs, do not exceed the baud rates recommended for the individual LAN
modes. See the LAN modes information for more details.

Setting a BIM’s LAN address
A BIM’s address on a LAN must be unique. The Configurator will warn the user if the address
is already in use for another BIM.

•  Click on the icon for the BIM and then click the Network Attributes tab in the Tab Bar.

•  In the LAN A Parameters section, use the up or down selection arrows on the Address box
to select the required address.

Modbus BIMS
If LAN A and LAN B are completely separate then the BIM can use the same address for both
of them but if the LANs are only different sections of the same LAN then the addresses must be
different to make them unique.

Note: The LAN B address is not relevant if Single LAN mode is selected and becomes greyed
out.

Setting configuration port parameters
The only setting required for the Configuration Port is to choose the PC serial COM port that
will be used.

To modify the Configuration Port parameters:

•  Click on the Network icon and choose the File Attributes tab in the Tab Bar.

•  In the Configuration Port Parameters section choose, from the drop-down list box, the PC
COM Port to be used.

Setting the LAN mode – Modbus only
This defines the status of the Modbus LAN(s); the redundancy, if any, and the use of the
Configuration/HMS Port. Full details on how each mode operates and the recommended
operating speed(s) can be found in the Instruction Manual for the Modbus BIM.

To set the Modbus LAN mode:

•  Click on the BIM icon in the Navigation Tree and then the Network Attributes tab

•  Choose the required mode from the options in the LAN Mode section (see
page 22).
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Downloading a new configuration to the BIM
This action will copy the configuration file from the Configurator database to the BIM. The
configuration may also be saved to the BIM’s non-volatile memory (NVM).

Think about the following points before downloading a configuration:

Do you have a copy of the current configuration in the BIM - so that it can be restored in the
event of a problem with the new configuration? If not, save the new configuration to file (see
page 45), then upload the current BIM configuration to the Configurator (see page 45) and save
that also. Re-open the new configuration file for downloading.

Do you want to overwrite the current configuration completely - or will you download the
configuration first and save to NVM later (recommended).

To download a configuration file, without saving it to NVM:
•  The BIM must be in communication with the Configurator.

•  Open the required configuration file, if not already open.

•  Click on the Network symbol in the Navigation Tree and select the Network Attributes tab.

•  Ensure that the Automatic Store to NVM box is NOT checked.

•  Click on the Download BIM icon on the Toolbar, or click Download BIM in the
Configuration menu.

A box appears on screen to show the progress of the download. Towards the end of the
download, a dialog box will ask if the configuration should be saved to non-volatile memory
(NVM).

Figure 72 – “Save to NVM” dialog box

•  Choose “Don’t Save the Configuration”

•  Click the OK button when the transmission is 100% complete.

To download the configuration file and save it to NVM,
The BIM must be in communication with the Configurator.

•  Open the required configuration file, if not already open.

•  Click on the Download BIM icon on the Toolbar, or click Download BIM in the
Configuration menu.

A box appears on screen to show the progress of the download. Towards the end of the
download, a dialog box will ask if the configuration should be saved to non-volatile memory
(NVM).

Figure 73 – “Save to NVM” dialog box

•  Choose “Save the Configuration to NVM”
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If the “Don’t ask me again” box is checked   , then the question box will not appear in future
and the configuration will get saved automatically to NVM. See also the File Attributes section.

•  Click the OK button when the transmission is 100% complete.

Viewing the Error Log
The Error log provides historical information about significant events for the BIM and I/O
modules. The data must be read from the BIM and is therefore available only when the Mode is
set to Manual or Auto.

To view the Error Log either:

•  Choose the Event Log option on the Configuration Menu, or

•  Right click on a BIM or module icon and select Event Log from the options

A dialog box appears offering different option.

Figure 74 - Event Log dialog box

Error Log
The Error Log provides a display of timed events that are significant in the operation of a BIM.

Data & Status
This option is not available at this time.

Options
These options are not available at this time.

Refresh rate
The rate at which the error log information is updated can be defined here. Enter a figure to
specify how often the data should be checked for new information.

Click OK for an on-screen view of the Error Log.

The Error Log displays the event messages, each of which is accompanied by its time stamp and
the identity of the module involved.

When the Event Log is displayed, the Menu bar changes. Three menu options are provided:
Event Log, Window and Help.

Figure 75 - Error Log display
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Refreshing the Error Log
The Menu Bar provides the option to Refresh the log. This adds any recent data to the screen
list.

Saving the Error Log
To Save a copy of the log in comma separated value (.csv) format click Save in the Event Log
menu option.

BIM tasks

Adding a BIM
To add a BIM to the network:

•  Click the “New BIM” button   on the Toolbar

Alternatively, right click on the network symbol and choose New BIM from the options
provided, or use the New | BIM options in the File Menu

•  The Create BIM dialog box appears.

Note: As the LAN protocol was been defined when the configuration file was created, there is
no need for a choice of alternative protocols.

Figure 76 – Create BIM dialog box

Name
This is descriptive, or tag, name for the BIM that the user can define. Up to 22 ASCII characters
are permitted.

LAN A address
This is the address of the BIM on LAN A. The range of values permitted is 1 to 125. The host,
as Master, has an address of 0. The default value is 126 and so this should be amended to the
required value.

Mode
This parameter specifies whether the Configurator will get updated with dynamic data, i.e. real
time BIM and module parameters, from the BIM.

See Mode (Edit Menu) for further details.

Deleting a BIM
•  Click on the BIM icon in the Navigation Tree and then click on Edit | Delete. A dialog box

appears and asks for confirmation:

“Are you sure you want to delete BIM xxxxx?”

•  Confirm the delete by clicking Yes or click No to abort the action.

Note: Another way to delete a BIM is to right click the mouse while pointing at it. Choose
Delete from the list of options. The same confirmation is required, as described above.

Editing BIM parameters
There are not many parameters that can be, or need to be, modified on the BIM. The details of
the BIM parameters are provided on page 21.
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Resetting the BIM
A BIM Reset will restart the BIM so that it adopts the states that are currently defined in NVM.
A reset can be used:

•  To make the BIM adopt new configuration details that have been downloaded to the BIM
and saved in NVM.

•  To restore the BIM to its previous configuration after (unsaved) changes to its
configuration.

To reset the BIM:

•  Click on the BIM icon in the Navigation Tree,

•  Choose the Reset option from the Configuration Menu, or

•  Right click on the BIM and choose the Reset option

Note: The Event Log is preserved in this process.

Setting and clearing BIM failsafe state
There may be occasions during commissioning when the BIM needs to be forced into a failsafe
state. For example, the input and output states of the I/O modules can be checked when they
also get forced into failsafe. After confirmation, the failsafe state can easily be cleared.

Setting to failsafe

To set a BIM into failsafe, select it in the Navigation Tree, then click on Configuration | Set
Failsafe to enforce the command.

Note: This can also be achieved by right clicking on the BIM and selecting Set Failsafe from
the option list provided.

Clearing failsafe

Select the BIM, then click on Configuration | Clear Failsafe to enforce the command.

Note: This can also be achieved by right clicking on the BIM and selecting Clear Failsafe from
the option list provided.

Viewing BIM hardware, software and firmware release information
To see the versions of hardware, software and firmware that a BIM is using:

•  Click on the BIM and then the BIM Properties tab. This will display all of the release
details. A typical display can be seen on page 21.

Viewing BIM status parameters
To view the current status parameters for the BIM:

•  Click on the BIM and then the Dynamic Data tab.

I/O module tasks

Adding a module
Up to 24 modules can be added to a Profibus BIM and up to 32 to a Modbus BIM.

To add a new module to a BIM:

•  Click the “New Module” button    on the Toolbar.

Alternatively, right click on a BIM or module symbol and choose New Module from the options
provided, or use the New | Module options in the File Menu

•  The Create Module dialog box appears.
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Figure 77 - Create module dialog box

BIM
This identifies the BIM to which the additional module will be attached.

Module type/Configuration type
This choice is not currently available but is reserved for a future version.

Type
Choose from the drop-down list box the module type required. See Appendix A for a full list of
available I/O modules.

Slot number
This defines the slot number the module will occupy. Choose from a range of 1 – 32 using the
drop-down list box.

Deleting a module
•  Click on the I/O module icon in the Navigation Tree and then click on Edit | Delete. A

dialog box appears and asks for confirmation:

“Are you sure you want to delete Module xxxx-xx-xx at Slot x?”

•  Confirm the delete by clicking Yes or click No to abort the action.

Note: Another way to delete a module is to right click the mouse while pointing at it. Choose
Delete from the list of options. The same confirmation is required, as described above.

Resetting a module
A Reset will reinitialise the I/O module and restores its default power-up conditions – see the
module’s data sheet for details. In the case of output modules, the output values are unchanged
by a reset.

To reset a module:

•  Click on the module icon in the Navigation Tree,

•  Choose the Reset option from the Configuration Menu, or right click on the module and
choose the Reset option

Editing module parameters
To edit the parameters for a module:

•  Click on the module icon then click on the Channel Attributes tab.

•  The parameters can then be modified according to the module type. See below for links to
the individual module types.

•  When the parameters have been modified, save the file and download it to the BIM (see
page 48).

The Channel Attributes for each module type can be viewed at the following locations:

•  DI modules – page 31

•  DO modules – page 32

•  AI modules – page 33

•  TI modules – page 34

•  AO modules – page 35

•  PI modules – page 36
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Setting and clearing I/O module failsafe state
An I/O module may need to be forced into failsafe, for example to check that it adopts the
correct input or output values when it enters failsafe. After confirmation, the failsafe state can
easily be cleared.

Setting to failsafe
To set a module into failsafe, select it in the Navigation Tree, then click on Configuration | Set
Failsafe to enforce the command.

Note: This can also be achieved by right clicking on the module and selecting Set Failsafe from
the option list provided.

Clearing failsafe
Select the I/O module, then click on Configuration | Clear Failsafe to enforce the command.

Note: This can also be achieved by right clicking on the I/O module and selecting Clear
Failsafe from the option list provided.

Setting input module failstate values
If an input module fails, or enters a failsafe condition - an event that could be caused by loss of
communications with the BIM - the input value could end up being undefined. To avoid this
situation, a specific failstate can be defined for each channel in a module. In the event of the
module entering failsafe, the BIM will report this value to the host as an indicator of its
condition.

DI modules
DI modules can be set to adopt one of three Failstate Values, namely:

•  Off

•  On

•  Hold Last Value

Choose the option that is required for each channel and then download the values to the BIM.
See the Channel Attributes tab – DI modules on page 31 for further details of these fields.

AI  & TI modules
AI and TI modules can be set to adopt one of four Failstate Conditions,

•  Low

•  High

•  Hold Last Value

•  Failstate Value

The Failstate Value option has a separate field that is used to define a specific percentage value
anywhere in the range of the analog input.

Choose the option that is required for each channel and then download the values to the BIM.
See the Channel Attributes tab – AI modules on page 33 for further details of these fields.

Note: The Configurator can be used to check that the module channels adopt the correct failstate
value or condition by putting the module into failsafe. See Section 0 for details on performing
this.

Setting output module failsafe values
If an output module enters a failsafe condition - an event that could be caused by loss of
communications with the BIM, or by the BIM itself going into failsafe - the output value could
end up being undefined. To avoid this situation, a specific failsafe condition can be defined for
each channel in a module. In the event of the module entering failsafe, this value will be output
to the field device until the module is recovered from failsafe.
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DO modules
DO modules can be set to adopt one of three Failsafe Values

•  Off

•  On

•  Hold Last Value

Choose the option that is required for each channel and then download the values to the BIM.
The BIM will then pass the configuration information to the appropriate module(s).

See the Channel Attributes tab – DO modules on page 32 for further details of these fields.

AO modules
AO modules can be set to adopt one of four Failsafe Conditions

•  Low

•  High

•  Hold Last Value

•  Failsafe Value

The Failsafe Value option has a separate field that is used to define a specific percentage value
anywhere in the range of the analog output.

Choose the option that is required for each channel and then download the values to the BIM.
The BIM will then pass the configuration information to the appropriate module(s).

See the Channel Attributes tab – AO modules on page 35 for further details of these fields.

Note: The Configurator can be used to check that the module channels adopt the correct failstate
value or condition by putting the module into failsafe. See Section 0 for details on performing
this.

Setting pulse mode for a DO
In addition to the discrete On or Off states of the digital output module, a pulse mode is also
available. Pulsed outputs can be either “single pulse” or “continuous pulse ”. Most modules use
the “static mode” recovery (see below) from a failsafe situation but certain modules (e.g. 8215-
DO-IS) also have a “dynamic mode” of recovery.

Single pulse mode
This is a one-off event that sends out a pulse of defined width, or On Time. Because it is
a single event the module will require a Reset to re-initialise it after the event.

Continuous pulse mode
This mode provides a continuous stream of pulses of defined width, or On Time
occurring with a defined frequency, or Period.
There are also Static and Dynamic options for the Single and Continuous pulse modes.
These define the behaviour of an output when entering or leaving the failsafe or inactive
states.

Static mode
When the module enters failsafe, or is made inactive, then pulse mode is disabled, the
channel is configured as a latched output and is driven to its failsafe value. The module
must then be re-initialised by the BIM before it can be restored to an operational
condition.

Dynamic mode
If the module enters failsafe, the output is driven to its failsafe value. If it is made
inactive, the output is turned Off (i.e. de-energised). On leaving the failsafe or inactive
state, the channel will resume operation with the previous configuration and output.

See Discrete output modules for details on selecting the Operation mode and the values and
constraints when setting the On-Time and Period.
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Activating/deactivating a channel
Individual channels in a module can be made active or inactive. Making any unused channels
inactive can improve response times slightly by cutting down on unnecessary data traffic.

To make a channel active:

•  Click on the module icon and then on the Channel Attributes tab

•  Identify the channel of interest and then check    the Active check box.

To make a channel inactive:

•  Click on the module icon and then on the Channel Attributes tab

•  Identify the channel of interest and then uncheck    the Active check box.

Viewing module status parameters
To view the status parameters for a module, or its current statistics:

•  Click on the module and then the Module Dynamic Data tab.

Upgrade analog module firmware
To upgrade the firmware of an analog module:

•  Click on the module name/icon in the navigation tree

•  Click Configuration | Reprogram or right click the name/icon and choose Reprogram

Choosing a revision level
•  Click on the down arrow in the Firmware Version field

•  Choose the required revision level and the Versions box will display the software
component and the (New) version number for the chosen level.

Choosing the latest revision level
•  Click on the Select Latest button and the display will show the latest revision level for

comparison with what is currently loaded.

Downloading the firmware
•  Click the OK button to start the download.

Note: The download will take a few minutes because of the speed of the communications link.
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Appendix A

Safe area and 2/2 modules
DI modules

8-channel DI, 24 V dc isolated, sinking 8109-DI-DC

8-channel DI, 24 V dc non-isolated, device-powered 8110-DI-DC

16-channel DI, 24 V dc non-isolated, module-powered 8121-DI-DC

16-channel DI, 24 V dc isolated, sinking 8122-DI-DC

8-channel DI, 115 V ac isolated, sinking 8111-DI-AC

8-channel DI, 115 V ac non-isolated, device-powered 8112-DI-AC

8-channel DI, 230 V ac isolated, sinking 8113-DI-AC

8-channel DI, 230 V ac non-isolated, device-powered 8114-DI-AC

DO modules

8-channel DO, 2–60 V dc non-isolated, device-powered 8115-DO-DC

8-channel DO, 2–60 V dc isolated, unpowered 8117-DO-DC

8-channel DO, 20–265 V ac non-isolated, device-powered 8116-DO-AC

8-channel DO, 20–265 V ac isolated, unpowered 8118-DO-AC

AI modules

8-channel AI, 4–20 mA with HART 8101-HI-TX

8-channel AI, 4-20 mA 8103-AI-TX

8-channel AI, 1–5V 8119-VI-05

TI modules

4-channel Thermocouple 8105-TI-TC

4-channel RTD 8106-TI-RT

PI modules

2-channel pulse/frequency input 8123-PI-QU

AO modules

8-channel AO, 4-20 mA with HART 8102-HO-IP

8-channel AO, 4–20 mA 8104-AO-IP

IS wiring 2/1 modules
DI modules

8/16-channel IS DI, switch/proximity detector 8220-DI-IS

DO modules

4-channel IS DO, solenoid driver, IIC gas groups 8215-DO-IS

AI modules

8-channel IS AI, 4–20 mA with HART 8201-HI-IS

8-channel IS AI, 0-10V / potentiometer input 8230-AI-IS

TI modules

8-channel IS Thermocouple 8205-TI-IS

8-channel IS RTD 8206-TI-IS

PI modules

2-channel IS pulse/frequency input 8223-PI-IS

AO modules

8-channel IS AO with HART, 4–20 mA 8202-AO-IS

8-channel IS AO, 4–20 mA 8204-AO-IS
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Appendix B

Glossary of Terms

AI
Analog input. Usually applied to a type of I/O module.

AO
Analog output. Usually applied to a type of I/O module.

BIM
A Bus Interface Module which manages communications between the I/O modules and the
Host/LAN.

Carrier
A mounting platform for MTL8000 modules; also provides electrical interconnections for them
via the in-built bus (Railbus).

DI
Discrete input. Usually applied to a type of I/O module.

DO
Discrete output. Usually applied to a type of I/O module.

Fieldbus
A generic term for the different communication protocols used in process control applications.

HART®
HART is a global protocol for communication with “smart” field devices. Digital data to and
from the field device is superimposed on the conventional analog signal. This data can be used
for remote management of the field device (e.g. calibration). HART® is a registered trademark
of the HART Communications Foundation.

I/O module
An interchangeable module that handles signals to or from the process sensors or controls.
Modules can contain four, eight or sixteen-channels, according to type, for analog and discrete
(switched) inputs and outputs.

LAN
A Local Area Network is a method of distributing communication and control signals around a
site, usually using coaxial or twisted-pair cabling. A LAN interconnects MTL8000 and the host
controller.

Mode
Modes define how the BIM will use the available LAN(s) and its configuration port. A mode
will also define how the BIM will manage redundant LANs in order to maintain
communications.

Module carrier
A carrier that holds either up to four or up to eight I/O modules only. One or more module
carriers connect to a node services carrier.

Node
The collective name given to a group of MTL8000 modules that serves a local group of field
instruments and controls.
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Node Services Carrier
A 'master' carrier that houses a BIM and may sometimes accommodate one or more power
supply modules and I/O modules.

NSM
Node Services module. A module that mounts beside the BIM, containing flash memory for the
node configuration together with addressing and auto-configuration switches.

NVM
Non-volatile memory. A re-writable memory storage device in a BIM that holds configuration
data.

Passthrough
The ability to pass HART data through a module even though the module has no intrinsic
HART capabilities of its own.

PI
Pulse (frequency) input. Usually applied to a type of I/O module.

Railbus
Proprietary serial bus which carries control information and power. It is distributed to modules
on the carriers and can be linked from one carrier to the next.

RTD
Resistance transmitter device. A type of field sensor for temperature measurement.

TI
Temperature (analog) input. Usually applied to a type of I/O module.

THC
Thermocouple. A type of field sensor for temperature measurement.
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Appendix C

Security access levels
The following table describes the levels of security access and the capabilities assigned to that
access category. The lowest level is Read Only and the top level is User Engineer (config.).
Higher categories have the access features of all those below them.

Access category Feature

User Engineer (config.) Create new file
Save a file
Edit the Railbus Pending timeout
Reset a BIM
Reset a module
Download a changed configuration to a BIM
Set / Clear Railbus CPU Failsafe
Request firmware download to Railbus CPU
Request firmware download to Application CPU
Request firmware download to modules

User Engineer (no config.) Add BIMs to the File Level display
Remove BIMs from the File level display
Set the BIM Refresh Attribute to Manual
Set the BIM Refresh Attribute to Automatic
Modify the Auxiliary link protocol parameters
Remove the configuration of a module
Display the Error Log for a BIM
Administer user names, passwords and authorities
Change own password
Screen refresh
Import configuration

User Technician Print a file
Set / clear a module’s Failsafe State
Edit the LAN node address
Modify the BIM auxiliary port node address
Edit and download BIM descriptive text

Read Only mode Read only access
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Software revision history

Version Date Details and supported features

2.01 May 2001 Beta version

2.02 Oct. 2001 Initial release

2.10 Nov. 2001 Upgrade:
•  support for new I/O modules
•  support for Node Services module (NSM)
•  bug fixes

2.20 Apr. 2002 Upgrade:
•  support for new I/O module
•  support for Version 2 Profibus BIM
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Tel: +971 2 63 22399   Fax: +971 2 63 22566
E-mail: mtlgulf@mtl-inst.com

MTL Instruments
Power Court, Luton, Bedfordshire
England  LU1 3JJ
Tel: +44 (0)1582 723633   Fax: ++44 (0)1582 422283
E-mail: enquiry@mtl-inst.com

MTL Incorporated
9 Merrill Industrial Drive, Hampton NH 03842
USA
Tel: +1 800 835 7075, +1 603 926 0090
Fax: +1 603 926 1899
E-mail: info@mtlnh.com


